Quartus Il Introduction Using Schematic Design

This tutorial presents an introduction to the Qua@.m CAD system. It gives a general overview of a typi-
cal CAD flow for designing circuits that are implemented byngsFPGA devices, and shows how this flow is
realized in the Quartus Il software. The design processuistibted by giving step-by-step instructions for using
the Quartus Il software to implement a very simple circuiaimAltera FPGA device.

The Quartus Il system includes full support for all of the plap methods of entering a description of the
desired circuit into a CAD system. This tutorial makes us¢hefschematic design entry method, in which the
user draws a graphical diagram of the circuit. Two otherivessof this tutorial are also available, which use the
Verilog and VHDL hardware description languages, respelti

The last step in the design process involves configuring #ségded circuit in an actual FPGA device. To
show how this is done, it is assumed that the user has accssAdtera DE2 Development and Education board
connected to a computer that has Quartus Il software iestalh reader who does not have access to the DE2
board will still find the tutorial useful to learn how the FP@Rogramming and configuration task is performed.

The screen captures in the tutorial were obtained using treat@s 1l version 8.0; if other versions of the
software are used, some of the images may be slightly differe
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Computer Aided Design (CAD) software makes it easy to imgeta desired logic circuit by using a pro-
grammable logic device, such as a field-programmable gedg FPGA) chip. A typical FPGA CAD flow is
illustrated in Figure 1.
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Figure 1. Typical CAD flow.

The CAD flow involves the following steps:

e Design Entry — the desired circuit is specified either by means of a scherdagram, or by using a
hardware description language, such as Verilog or VHDL

e Synthesis-the entered design is synthesized into a circuit that stsef the logic elements (LES) provided
in the FPGA chip

e Functional Simulation — the synthesized circuit is tested to verify its functiot@irectness; this simulation
does not take into account any timing issues



e Fitting — the CAD Fitter tool determines the placement of the LEs @efiim the netlist into the LEs in
an actual FPGA chip; it also chooses routing wires in the thimake the required connections between
specific LEs

e Timing Analysis — propagation delays along the various paths in the fittexitiare analyzed to provide
an indication of the expected performance of the circuit

e Timing Simulation — the fitted circuit is tested to verify both its functionak@rtness and timing

e Programming and Configuration — the designed circuit is implemented in a physical FPGA tlyijpro-
gramming the configuration switches that configure the LEsemtiablish the required wiring connections

This tutorial introduces the basic features of the Quartseftware. It shows how the software can be used to
design and implement a circuit specified by means of a schemiagram. It makes use of the graphical user
interface to invoke the Quartus Il commands. Doing thisratpthe reader will learn about:

e Creating a project

Entering a schematic diagram

Synthesizing a circuit from the schematic diagram

Fitting a synthesized circuit into an Altera FPGA

Assigning the circuit inputs and outputs to specific pinstsnEPGA

Simulating the designed circuit

Programming and configuring the FPGA chip on Altera’s DE2rboa

1 Getting Started

Each logic circuit, or subcircuit, being designed with Quail software is called project The software works
on one project at a time and keeps all information for thajqatdn a single directory (folder) in the file system.
To begin a new logic circuit design, the first step is to creathrectory to hold its files. To hold the design files
for this tutorial, we will use a directorintrotutorial. The running example for this tutorial is a simple circuit fo
two-way light control.

Start the Quartus Il software. You should see a display amtd the one in Figure 2. This display consists
of several windows that provide access to all the feature3uafrtus Il software, which the user selects with the
computer mouse. Most of the commands provided by Quartustiliare can be accessed by using a set of menus
that are located below the title bar. For example, in Figuolicking the left mouse button on the menu named
File opens the menu shown in Figure 3. Clicking the left mouseohubin the entryExit exits from Quartus Il
software. In general, whenever the mouse is used to selewthing, thdeft button is used. Hence we will not
normally specify which button to press. In the few cases whismecessary to use thigght mouse button, it will
be specified explicitly.
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Figure 2. The main Quartus Il display.
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For some commands it is necessary to access two or more nreseguence. We use the conventidenul
> Menu2 > Item to indicate that to select the desired command the userdffiesti click the left mouse button
on Menul, then within this menu click oMenu2, and then withirMenu?2 click on Item. For exampleFile >
Exit uses the mouse to exit from the system. Many commands candieeih by clicking on an icon displayed in
one of the toolbars. To see the command associated with anposition the mouse over the icon and a tooltip
will appear that displays the command name.

1.1 Quartus Il Online Help

Quartus Il software provides comprehensive online docuatiem that answers many of the questions that may
arise when using the software. The documentation is acddss® theHelp menu. To get some idea of the
extent of documentation provided, it is worthwhile for tieader to browse through tlielp menu. For instance,
selectingHelp > How to Use Help gives an indication of what type of help is provided.

The user can quickly search through the Help topics by setgktelp > Search, which opens a dialog box
into which keywords can be entered. Another method, cortemsitive help, is provided for quickly finding
documentation for specific topics. While using most applicet, pressing th&1 function key on the keyboard
opens a Help display that shows the commands availabledahlication.

2 Starting a New Project

To start working on a new design we first have to define a degign project Quartus Il software makes the
designer’s task easy by providing support in the form ofizard Create a new project as follows:

1. Selecfile > New Project Wizard to reach the window in Figure 4, which asks for the name arettbry
of the project.

New Project Wizard: Directory, Name, Top-Level Entity [page 1 of 5]

‘what iz the working directory for this project?

|D:.-"intr0tut0rial
‘what iz the name of this project?
[ight

‘what iz the name of the top-level design entity for this project? Thiz name iz caze sensitive and must
exactly match the entity name in the design file.

light [

Usze Existing Project Settings ...

| Mest > | Finizh | Cancel

Figure 4. Creation of a new project.



2. Set the working directory to biatrotutorial; of course, you can use some other directory name of your
choice if you prefer. The project must have a name, whichugllisthe same as the top-level design entity
that will be included in the project. Chookght as the name for both the project and the top-level entity, as
shown in Figure 4. Presdext. Since we have not yet created the directiotyotutorial, Quartus Il software
displays the pop-up box in Figure 5 asking if it should crehtedesired directory. Clickes, which leads
to the window in Figure 6.

1 E Directory "Dt fintrotutorial” does not exist, Do you wank to create it?
L

es Mo |

Figure 5. Quartus Il software can create a new directorytferroject.

New Project Wizard: Add Files [page 2 of 5] PZ|

Select the design files you want to include in the project. Click Add All to add all design files in the
project directory to the project. Mote: you can alwaps add design files to the project later.

File name: | J
File nare | Type | Library | Design entry/sy... | HOL wersion Add Al

dil

< *

Specify the path names of any non-default libraries. Izer Libraries...

< Back | Mest > | Finizh | Cancel |

Figure 6. The wizard can include user-specified design files.

3. The wizard makes it easy to specify which existing fileaiy) should be included in the project. Assuming
that we do not have any existing files, clislext, which leads to the window in Figure 7.



New Project Wizard: Family & Device Settings [page 3 of 5]

Select the family and device you want to target for compilation.

Device family Shaow in ‘Available device' list
FEamily: | Cyclone |1 j Package: Ay A
| J Fin count: Ay hd
Target device Speed grade: | Any -
" Auto device selected by the Fitter ¥ Show advanced devices
+ Specific device selected in ‘Svailable devices' list r

Ayailable devices:

Mame Caorew.. | LEs User /.. | Memar... | Embed... | PLL »~
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EP2C200240C8 1.2 18752 142 239616 B2 4
EP2C35F484C6 129 33216 322 483840 70 4
EP2C35F484C7 129 33216 322 483840 70 4
EP2C35F484C8 129 33216 322 483840 70 4
35F. 1.2 322 0 70 4
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< Back | Mest > | Finizh | Cancel |

Figure 7. Choose the device family and a specific device.

4. We have to specify the type of device in which the desigiredi¢ will be implemented. Choose Cycloh¥
Il as the target device family. We can let Quartus Il softwegkect a specific device in the family, or we can
choose the device explicitly. We will take the latter apgtoaFrom the list of available devices, choose the
device called EP2C35F672C6 which is the FPGA used on A&&?2 board. Predsext, which opens the
window in Figure 8.



New Project Wizard: EDA Tool Settings [page 4 of 5]

Specify the other EDA tools - in addition to the Quartus || software - used with the project.

Design Entry/Synthesis

Tool name:

-

Simulation

Tool name: | <Maone:

Ll Lo

-

Timing Analysiz

Tool name: | <Maone:

Ll Lo

-

< Back | Mest > | Finizh | Cancel |

Figure 8. Other EDA tools can be specified.

5. The user can specify any third-party tools that shouldds=iu A commonly used term for CAD software
for electronic circuits i€£DA tools where the acronym stands for Electronic Design Automafidms term
is used in Quartus Il messages that refer to third-partystaghich are the tools developed and marketed
by companies other than Altera. Since we will rely solely ara@us Il tools, we will not choose any other
tools. Presdext.

6. A summary of the chosen settings appears in the screemshdwvigure 9. PresBinish, which returns to
the main Quartus Il window, but witlight specified as the new project, in the display title bar, achteid
in Figure 10.



New Project Wizard: Summary [page 5 of 5]

‘wihen vou click Finish, the project will be created with the following settings:

Project directory:
[ #tyiwdork/UP Documentations' T utorialz/M 3-intro-zchemdintrotutorial

Froject name: light
Top-level design entity: light
Mumber of files added: 1]

Mumber of user libraries added: 0

Device assignments:

Family name: Cyclone ||

Device: EP2C35FET2CE
ED& tools:

Dresign entry/spnthesis: <Mone>

Simulatior: <Mone:

Timing analysiz: <Mone>

Operating conditions:
Core voltage: 1.29
Junction temperature range:  0-85 *C

< Back | et > Cancel |

Figure 9. Summary of the project settings.
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Figure 10. The Quartus Il display for the created project.



3 Design Entry Using the Graphic Editor

As a design example, we will use the two-way light controdliecuit shown in Figure 11. The circuit can be used

to control a single light from either of the two switches,andz2, where a closed switch corresponds to the logic
value 1. The truth table for the circuit is also given in theufig Note that this is just the Exclusive-OR function

of the inputsz, andx-, but we will implement it using the gates shown.

X > o

/
0
1
1
0

-
-

X

Figure 11. The light controller circuit.

The Quartus Il Graphic Editor can be used to specify a ciricuihe form of a block diagram. SeleEile
> New to get the window in Figure 12, choo&ock Diagram/Schematic File, and clickOK. This opens the
Graphic Editor window. The first step is to specify a namelfierfile that will be created. Seleeile > Save As to
open the pop-up box depicted in Figure 13. In the box lab8kage as type chooseBlock Diagram/Schematic
File (*.bdf). In the box labeledrile name typelight, to match the name given in Figure 4, which was specified
when the project was created. Put a checkmark in theAslkfile to current project. Click Save, which puts
the file into the directoryntrotutorial and leads to the Graphic Editor window displayed in Figure 14

SOPC Builder System ~

=I- Deszign Files
AHDL File

Block Diagram/S chematic File
EDIF File
State Machine File
Systemerlog HOL File
Tel Script File
Werilog HOL File
WHOL File

=I- Memary Files
Hexadecimal [Intel-Format] File
Memory Initislization File

=I- Yerification/Debugging Files
In-System Sources and Probes File
Logic Analyzer Interface File
SignalT ap | Logic Analyzer File
Wector Waveform File

—|- Other Files
AHDL Include File
Block Symbal File
Chain Description File
Synopsys Design Constraints File
Text File

v

Cancel

Figure 12. Choose to prepare a block diagram.
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Figure 14. Graphic Editor window.

3.1 Importing Logic-Gate Symbols

The Graphic Editor provides a number of libraries which uddg circuit elements that can be imported into a
schematic. Double-click on the blank space in the GraphitoEdindow, or click on theT* icon in the toolbar
that looks like an AND gate. A pop-up box in Figure 15 will appeExpand the hierarchy in the Libraries box as
shown in the figure. First exparitbraries, then expand the libramgrimitives followed by expanding the library
logic which comprises the logic gates. Selantl2 which is a two-input AND gate, and clicdRK. Now, the AND
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gate symbol will appear in the Graphic Editor window. Usihg tmouse, move the symbol to a desirable location
and click to place it there. Import the second AND gate, whiah be done simply by positioning the mouse
pointer over the existing AND-gate symbol, right-clickiramd dragging to make a copy of the symbol. A symbol
in the Graphic Editor window can be moved by clicking on it atrelgging it to a new location with the mouse
button pressed. Next, selemt2 from the library and import the OR gate into the diagram. Theatectnotand
import two instances of the NOT gate. Rotate the NOT gatespnbper position by using the “Rotate left 90"

icond=. Arrange the gates as shown in Figure 16.

Libraries:

= @' d:/alera/80/ quartus/libraries »
FIET megafunctions
BT others
EHE primitives

Mame:

|and2 J

™ Bepeat-inzert mode
-
-

Megawizard Plug-In Manager... |

Qg Lancel |

Figure 15. Choose a symbol from the library.

i light. bdf*

Figure 16. Import the gate symbols into the Graphic Editardeiv.
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3.2 Importing Input and Output Symbols

Having entered the logic-gate symbols, it is now necessegpnter the symbols that represent the input and output
ports of the circuit. Use the same procedure as for impotttieggates, but choose the port symbols from the
library primitives/pin Import two instances of the input port and one instance efdlitput port, to obtain the
image in Figure 17.

Figure 17. Import the input and output pins.

Assign names to the input and output symbols as follows. Maike nothing is selected by clicking on an
empty spot in the Graphic Editor window. Point to the wpid_nameon the top input symbol and double-click
the mouse. The dialog box in Figure 18 will appear. Type tmengimez1, and clickOK. Similarly, assign the
namez?2 to the other input ang to the output. Alternatively, it is possible to change thenraof an element by
selecting it first, and then double-clicking on the name gpihg a new one directly.

Pin Properties Pz|

General l Farmat ]

To create multiple pins, enter a name in AHDL bus notation [for example,
"namel3..0]"]. or enter a comma-separated list of names.

Fin name(z]: |x1

Drefault value: |VEE j

(] 8 | Cancel

Figure 18. Naming of a pin.
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3.3 Connecting Nodes with Wires

The symbols in the diagram have to be connected by drawieg [wires). Click on the ico” ! in the toolbar to
activate the Orthogonal Node Tool. Position the mouse pointer the right edge of thel input pin. Click and
hold the mouse button and drag the mouse to the right untdtéen line reaches the pinstub on the top input of
the AND gate. Release the mouse button, which leaves thedineecting the two pinstubs. Next, draw a wire
from the input pinstub of the leftmost NOT gate to touch theavthat was drawn above it. Note that a dot will
appear indicating a connection between the two wires.

Use the same procedure to draw the remaining wires in theitit€a mistake is made, a wire can be selected
by clicking on it, and removed by pressing the Delete key enkisyboard. Upon completing the diagram, click
on the iconk, to activate the Selection Tool. Now, changes in the appearaf the diagram can be made by
selecting a particular symbol or wire and either moving iatdifferent location or deleting it. The final diagram
is shown in Figure 19; save it.

i light. bdf*

Figure 19. The completed schematic diagram.

4 Compiling the Designed Circuit

The entered schematic diagram filight.bdf, is processed by several Quartus Il tools that analyze thesfjin-
thesize the circuit, and generate an implementation ofritHe target chip. These tools are controlled by the
application program called tHéompiler.

Run the Compiler by selectingrocessing > Start Compilation, or by clicking on the toolbar ico ® that
looks like a purple triangle. As the compilation moves tlylowarious stages, its progress is reported in a window
on the left side of the Quartus Il display. Successful (orugressful) compilation is indicated in a pop-up box.
Acknowledge it by clickingOK, which leads to the Quartus Il display in Figure 20. In the sage window, at the
bottom of the figure, various messages are displayed. Inafaseors, there will be appropriate messages given.

When the compilation is finished, a compilation report is pi@t. A window showing this report is opened
automatically, as seen in Figure 20. The window can be résip@ximized, or closed in the normal way, and it

can be opened at any time either by selecBngcessing > Compilation Report or by clicking on the icors® .

The report includes a number of sections listed on the ldf sif its window. Figure 20 displays the Compiler
Flow Summary section, which indicates that only one logarednt and three pins are needed to implement this
tiny circuit on the selected FPGA chip.
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Figure 20. Display after a successful compilation.
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4.1 Errors

Quartus Il software displays messages produced duringitatiop in the Messages window. If the block diagram
design file is correct, one of the messages will state thatdhepilation was successful and that there are no errors.

If the Compiler does not report zero errors, then there igadtlone mistake in the schematic entry. In this
case a message corresponding to each error found will blagiégpin the Messages window. Double-clicking
on an error message will highlight the offending part of tirewit in the Graphic Editor window. Similarly, the
Compiler may display some warning messages. Their detaiise explored in the same way as in the case of
error messages. The user can obtain more information alspédfic error or warning message by selecting the
message and pressing the function key.

To see the effect of an error, open the fight.bdf. Remove the wire connecting the output of the top AND

gate to the OR gate. To do this, click on {liteicon, click the mouse on the wire to be removed (to selectit) a
press Delete. Compile the erroneous design by clicking @ ®.hcon. A pop-up box will ask if the changes made
to thelight.bdffile should be saved; clickes. After trying to compile the circuit, Quartus Il softwarelidisplay

a pop-up box indicating that the compilation was not sudoésacknowledge it by clickingOK. The compilation
report summary, given in Figure 21, now confirms the failesilite Expand thé\nalysis & Synthesis part of the
report and then seleMessages to have the messages displayed as shown in Figure 22. Dolitkesn the first
error message, which states that one of the nodes is missimgree. Quartus Il software responds by displaying
thelight.bdfschematic and highlighting the OR gate which is affectechieyetrror, as shown in Figure 23. Correct
the error and recompile the design.

5 Compilation Report - Flow Summary

EhE Legal Notice
&S Flow Summary Flow Status Flow Failed - Wed Jun 25 11:00:55 2008
gg B b, | Qs Version 5.0 Buid 215 05/23/2008 5 Full Version
@5 Flow Elapsed Time Fievizion Mame light
@ Flow Log Top-level Entity Mame light
+- &0 Anabysis & Synthesis Famnily Cyelone |1
Device EP2C35FET2CE
Timing Models Final
Met timing requirements MAa
Total logic elements M8, until Partition Merge
Total combinational functions M8, until Partition Merge
Dedicated logic registers M8, until Partition Merge
Total registers M8, until Partition Merge
Total pinz M8, until Partition Merge
Total wirtual ping M8, until Partition Merge
Total memary bits M8, until Partition Merge
Embedded Multiplier 3-bit elements  M44 until Partition Merge
Total PLLs M8, until Partition Merge
< ¥

Figure 21. Compilation report for the failed design.
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- Compilation Report - Analysis & Synthesis Messages

3 Compilation Report Analysis & Synthesis Messages
i ERB Legal Notice ' Bissage
- ¢ZHPE Flow Summary s
: . Infao:
HEE Flow Settings By Info: Bunning Quartus IT Analysiz ¢ Synthesis
é% Elows Non-Defa?.lIt Glbalsetn L) Info: Command: quartus map --read settings files=on --write settings files=off light -c light
i é Flow Elapsed Time L) Info: Found 1 design units, including 1 entities, in source £ile light.bdf
é Eiowfleg Info: Elaborating entity "light™ for the top level hierarchy
= étjnnalysls&synthesls [x] Error: Port "IN1" of type ORZ of instance "inat2"™ is misaing 3ource signal
5% Summery: [ %] Error: Can't elaborate top-level user hierarchy
= ég Sothings " Error: Quartus IT Analysis & Synthesis was unsuccessful. 2 errors, 0 warnings

& K Messages

Processing (8) , Ewtra Info }\ Infa [5) }\ ‘Warning Critical \Warning )\ Enor (3] }\ F\agf

¢ IS Message: Dof 15 _]_3;J1 J Locals

Figure 22. Error messages.

i light. bdf.

Figure 23. Identifying the location of the error.

5 Pin Assignment

During the compilation above, the Quartus Il Compiler wagfto choose any pins on the selected FPGA to serve
as inputs and outputs. However, the DE2 board has hardwinekections between the FPGA pins and the other
components on the board. We will use two toggle switcheg|éals W, and STV, to provide the external inputs,

21 andx,, to our example circuit. These switches are connected tBRIG2A pins N25 and N26, respectively. We
will connect the outpuyf to the green light-emitting diode labeléd” DG, which is hardwired to the FPGA pin
AE22.
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Figure 24. The Assignment Editor window.

Pin assignments are made by using the Assignment EditoectSedsignments > Assignment Editor to
reach the window in Figure 24. Unde€ategory selectPin. Double-click on the entry<new>> which is
highlighted in blue in the column labeled To. The drop-dowenmin Figure 25 will appear. Click anl as the
first pin to be assigned,; this will entei in the displayed table. Follow this by double-clicking oe thox to the
right of this newx1 entry, in the column labeled Location. Now, the drop-dowmmin Figure 26 appears. Scroll
down and seled?IN_N25. Instead of scrolling down the menu to find the desired pin, gan just type the name
of the pin (N25) in the Location box. Use the same procedusessign inputr2 to pin N26 and outpuf to pin
AE22, which results in the image in Figure 27. To save thegassents made, choosdéle > Save. You can also
simply close the Assignment Editor window, in which case p-pp box will ask if you want to save the changes
to assignments; clickes. Recompile the circuit, so that it will be compiled with thereect pin assignments.

Tao

o f
1
2

Figure 25. The drop-down menu displays the input and outpotas.

Location |I,|’O Bank If0 Standard General Function Special Fur
| PN _zs)| B 3,34 LVTTL Dedicated Clock CLK4, LWDE
PIN_MzZ IJOBank5  Row Lo LvDS1Z2p ~
PIN_M23 IjOBank 5 Row IfO LVDS122n

PIN_Mz24 IJOBank5  RowIf0 L¥DS125p

PIN_M25 IjOBank 5 Row IfO LVDS125n

PIN_M1 Ij0 Bank 2 Dedicated Clock CLE1, LYDSCLKOR, Inpuk

PIN_NZ2 Ij0 Bank 2 Dedicated Clock CLKQD, LYDSCLKOp, Input

PIN_NS IJOBank2  Row I LvDS31p

PIN_N1E I)OBank5  Row 0 LvDS110p

PIN_NZ0 IJOBank5  RowIf0 LyDS124p

PIN_NZ3 IJOBank5  RowIf0 L¥DS126p, DPCLKFDOSORMCQIR

PIN_NZ24

Ij0 Bank 5

O Bank 5

I Bank 5

Row Ij0

ik

Dedicated Clack

LVDS126n
o dnput

CLKS, LYDSCLK2n, Input

I} Bank 1 Dedicated Clock CLES, LYDSCLK LR, Input

I} Bank 1 Dedicated Clock CLKZ, LVDSCLK1p, Input

LOBank1  Row Lo L¥DS26p, DPCLKL/DQS1L/CQILE

IfC Bank. 1 Row IfO LVDS26n

IfC Bank. 1 Row IfO LVDS22n

LOBank1  Row Lo LVDS22p

Ij Bank 2 Row IJO LYDS31n v

Figure 26. The available pins.
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¥ Assignment Editor*

kA
=l +  Category: | Pin

4 5 [ show assignments For specific nodes:

j @ all | (b Tirning | * Logic Options |

=
=3
=5
i
I
&

Check Al
Uncheck Al
Delete Al

|
=l + Information: | This cell specifies the pin name to which you want ko make an assignment, - Double-click to create a new assignment.

|

Edit: M| |<<new>>
|T0 Location If0 Bank 1/ Standard General Function Special Function
1 |1 PIN_NZS 5 3.3 LYTTL Dedicated Clack CLK4, LYDSCLKZD, T
z |2 PIN_NZ6 3 3.3 LYTTL Dedicated Clack CLKS, LYDSCLKZN, 1
3 L F PIN_AEZZ 7 3.5-Y LYTTL Column I LYDS5155n
LLNEW >

I

Figure 27. The complete assignment.

The DE2 board has fixed pin assignments. Having finished osigmethe user will want to use the same
pin assignment for subsequent designs. Going through theedure described above becomes tedious if there
are many pins used in the design. A useful Quartus Il featilmevsithe user to both export and import the pin
assignments from a special file format, rather than credtiagn manually using the Assignment Editor. A simple
file format that can be used for this purpose ise¢bhenma separated value (CSigymat, which is a common text
file format that contains comma-delimited values. This filefat is often used in conjunction with the Microsoft
Excel spreadsheet program, but the file can also be createdrlyusing any plain ASCII text editor. The format
for the file for our simple project is

To, Location
x1, PIN_N25
x2, PIN_N26
f, PIN_AE22

By adding lines to the file, any number of pin assignments eacrbated. Sucbsvfiles can be imported into any
design project.

If you created a pin assignment for a particular project, gan export it for use in a different project. To see
how this is done, open again the Assignment Editor to reaelwthdow in Figure 27. Now, seleEile > Export
which leads to the window in Figure 28. Here, the fight.csvis available for export. Click ofExport. If you
now look in the directoryntrotutorial, you will see that the fildight.csvhas been created.
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Save in: |_) introtutarial LJ g =k EB-
IChdb

&

My Recent
Documents

— N

[esklop

U

My Documents

&

5
My Computer
4
My Metwork, File name: Iiu:]h LJ E=port
Flaces
Save as type: |Eomma Separated Yalue File [* cav] ﬂ Cancel

Figure 28. Exporting the pin assignment.

You can import a pin assignment by choosigsignments > Import Assignments. This opens the dia-
logue in Figure 29 to select the file to import. Type the namtheffile, including thecsvextension and the full
path to the directory that holds the file, in the File Name bad pressOK. Of course, you can also browse to find
the desired file.

Import Assignments @

Specify the source and categories of azsignments to import. Click LogicLock Import File Assignments
to zelect LogicLock Import File[z].

Aszsignment source
+ File name: |
" Use LogicLock Import File Assignments 4

[v Copy existing assignments into light.gsf bak before imparting

| Cancel |

Figure 29. Importing the pin assignment.

For convenience when using large designs, all relevantgsiyaments for the DE2 board are given in the file
calledDE2_pin_assignments.c8vthe directoryDE2_tutorials design_fileswhich is included on the CD-ROM
that accompanies the DE2 board and can also be found on AIRE2 web pages. This file uses the names found
in theDE2 User Manual If we wanted to make the pin assignments for our examplelitiby importing this file,
then we would have to use the same names in our Block Diagdmaftatic design file; namelgW[0], SW[1]
andLEDGIO0] for x1, x2 andf, respectively. Since these signals are specified ilD2 pin_assignments.cfie
as elements of vecto®WandLEDG, we must refer to them in the same way in our design file. Fomgie, in
the DE2_pin_assignments.cfile the 18 toggle switches are call€@W[17]to SW[0]. In a design file they can
also be referred to as a vec®wW[17..0]
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6 Simulating the Designed Circuit

Before implementing the designed

the test vectors, as follows:

1. Open the Waveform Editor window by selectifide > New, which gives the window shown in Figure 30.

circuit in the FPGA chiptlom DE2 board, it is prudent to simulate it to
ascertain its correctness. Quartus Il software includésalation tool that can be used to simulate the behavior
of a designed circuit. Before the circuit can be simulatet necessary to create the desired waveforms, called
test vectorsto represent the input signals. It is also necessary tafgpeigich outputs, as well as possible internal
points in the circuit, the designer wishes to observe. Thwikitor applies the test vectors to a model of the
implemented circuit and determines the expected respdisavill use the Quartus Il Waveform Editor to draw

ChooseVector Waveform File and clickOK.

SOPC Builder System ~
Deszign Files

AHDL File

Block Diagram/S chematic File

EDIF File

State Machine File

Systemerlog HOL File

Tel Script File

Werilog HOL File

WHOL File
Memary Files

Hexadecimal [Intel-Format] File

Memory Initislization File
Yerification/Debugging Files

In-System Sources and Probes File

Logic Analyzer Interface File
SignalT ap | Logic Analyzer File
e weform File

Other Files
AHDL Include File
Block Symbal File
Chain Description File
Synopsys Design Constraints File

Text File W

Cancel

Figure 30. Need to prepare a new file.

2. The Waveform Editor window is depicted in Figure 31. Sdneefile under the nameght.vwf, note that this
changes the name in the displayed window. Set the desiradation to run from 0 to 200 ns by selecting
Edit > End Time and entering 200 ns in the dialog box that pops up. Selestiagy > Fit in Window
displays the entire simulation range of 0 to 200 ns in the windhs shown in Figure 32. You may wish to

resize the window to its maximum size.
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B light. vwf

CEBX

Master Time Bar: 15.95 nz 4| +| Painter: 4.7 nz Interval: 11.25 ns Start: End:
vaa | PP 100 ns 200 ns |
Name 15.95 nz 15.95 ne
|
gl >

Figure 31. The Waveform Editor window.

B light.vwi* 9((=E3
Master Time Bar: 15.95 nz 1| ¥| Painter: 968 nz Interval: £.27 nz Start: 0ps End: 200.0 nz
0 pz 400 nz 80.0 nz 120.0 ns 160.0 nz 200.0 n4
Name Walue at i i i i
15.95 nz 15.95 ne

|

Figure 32. The augmented Waveform Editor window.

3. Next, we want to include the input and output nodes of theuttito be simulated. ClickEdit > Insert >
Insert Node or Bus to open the window in Figure 33. It is possible to type the nafree signal (pin) into
the Name box, but it is easier to click on the button labéledie Finder to open the window in Figure
34. The Node Finder utility has a filter used to indicate wigpetof nodes are to be found. Since we are
interested in input and output pins, set the filtePios: all. Click the List button to find the input and
output nodes as indicated on the left side of the figure.

Mame:
Type:
Walue type:
Radix:
Bus width:

Start index:

| oK. |
[INPUT | Cancel

| SLevel j Mode Finder...
[asCi =

i

|o

[ Display gray code count as binary count

Figure 33. The Insert Node or Bus dialogue.
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Mamed: |i j Filter: |Pins: all j Custamize... | List Q QK |
Lock in: jJ V' Include subentities | Cancel |
Modes Found: Selected Nodes:
Mame Aszzignments | Tupe | Mame Aszsighments | Type
>
I f PIN_&E22 Output 9 [lightl1 PIN_N25 Input
| PIN_NZ5 Input [ B lightlx2 PIN_MZ2E Input
2 PIN_N26 Input L lightlf PIN_&E22 Output
<
<<
< ¥ J < ¥

Figure 34. Selecting nodes to insert into the Waveform Edito

Click on thex1signal in the Nodes Found box in Figure 34, and then click-tfsggn to add it to the Selected
Nodes box on the right side of the figure. Do the samexfbandf. Click OK to close the Node Finder
window, and then cliclOK in the window of Figure 33. This leaves a fully displayed Wavem Editor
window, as shown in Figure 35. If you did not select the noddbé same order as displayed in Figure 35,
it is possible to rearrange them. To move a waveform up or dawime Waveform Editor window, click on
the node name (in the Name column) and release the mouse bilithe waveform is now highlighted to
show the selection. Click again on the waveform and drag dngown in the Waveform Editor.

I light. vwf CEX
Master Time Bar: 15.95 nz 1| ¥| Painter: 10,08 nz Interval: 5.89ns Start: 0ps End: 200.0 nz

0 pz 400 nz 80.0 nz 120.0 ns 160.0 nz 200.0 n4

Name Walue at i i i i
15.95 s 15-933 ns

w0 «1 A0
1 %2 A0
£ 2 f A

Figure 35. The nodes needed for simulation.

4. We will now specify the logic values to be used for the ingighalsx1 andx2 during simulation. The logic
values at the outputwill be generated automatically by the simulator. To makeaity to draw the desired
waveforms, the Waveform Editor displays (by default) v@tiguidelines and provides a drawing feature
that snaps on these lines (which can otherwise be invoketdxysingView > Snap to Grid). Observe also
a solid vertical line, which can be moved by pointing to itg tmd dragging it horizontally. This reference
line is used in analyzing the timing of a circuit; move it tettime = 0 position. The waveforms can be

drawn using the Selection Tool, which is activated by seigdahe iconk in the toolbar, or the Waveform
Editing Tool, which is activated by the icc#2 .
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To simulate the behavior of a large circuit, it is necessagpply a sufficient number of input valuations and
observe the expected values of the outputs. In a large titwinumber of possible input valuations may
be huge, so in practice we choose a relatively small (buessgpntative) sample of these input valuations.
However, for our tiny circuit we can simulate all four inpwtluations given in Figure 11. We will use four
50-ns time intervals to apply the four test vectors.

We can generate the desired input waveforms as follows.k @licthe waveform name for thel node.
Once a waveform is selected, the editing commands in the MfaweEditor can be used to draw the desired
waveforms. Commands are available for setting a seleaj@dlsio 0, 1, unknown (X), high impedance (2),
don't care (DC), inverting its existing value (INV), or deifig a clock waveform. Each command can be
activated by using th&dit > Value command, or via the toolbar for the Waveform Editor. The Bui#nu
can also be opened by right-clicking on a waveform name.

Setx1to 0 in the time interval 0 to 100 ns, which is probably alreadiyby default. Next, setlto 1 in the
time interval 100 to 200 ns. Do this by pressing the mouseeastart of the interval and dragging it to its
end, which highlights the selected interval, and choodieddgic value 1 in the toolbar. Make = 1 from

50 to 100 ns and also from 150 to 200 ns, which correspondsettrilth table in Figure 11. This should
produce the image in Figure 36. Observe that the oufpsitdisplayed as having an unknown value at this
time, which is indicated by a hashed pattern; its value vélbletermined during simulation. Save the file.

B light.vwf* =3
Master Time Bar: 0ps 1| ¥| Painter: 166.25 ng Interval: 166.25 ng Start: End:
0 pz 200 nz 400 nz B0.0 nz 80.0 nz 100.0 ns 120.0 ns 140.0 nz 160.0 nz 180.0 nz |
m Value at i i i i i i i i i
ame Ops 0ps
w0 «1 A0 |
1 %2 A0 |
£ 2 f A
< ¥

Figure 36. Setting of test values.

6.1 Performing the Simulation

A designed circuit can be simulated in two ways. The simplest is to assume that logic elements and intercon-
nection wires in the FPGA are perfect, thus causing no delgyapagation of signals through the circuit. This
is calledfunctional simulation A more complex alternative is to take all propagation delisyo account, which
leads tatiming simulation Typically, functional simulation is used to verify the fttional correctness of a circuit
as it is being designed. This takes much less time, becaasgrttulation can be performed simply by using the
logic expressions that define the circuit.

6.1.1 Functional Simulation

To perform the functional simulation, sele&ssignments > Settings to open the Settings window. On the left
side of this window click orSimulator Settings to display the window in Figure 37, chooBenctional as the
simulation mode, and clickK. The Quartus Il simulator takes the inputs and generatesutpeits defined in the
light.vwffile. Before running the functional simulation it is necegda create the required netlist, which is done

24



by selectingProcessing > Generate Functional Simulation Netlist. A simulation run is started blprocess-

ing > Start Simulation, or by using the icor. At the end of the simulation, Quartus Il software indicdtes
successful completion and displays a Simulation Repastitated in Figure 38. If your report window does not
show the entire simulation time range, click on the reportdeiv to select it and choo&&ew > Fit in Window.
Observe that the outpiftis as specified in the truth table of Figure 11.

Settings - light

Category:

- Libraries A
- Device i
|=1 Operating Settings and Conditions Select simulation options.
- Woltage
o Temperature
- Compilation Process Settings

- Early Timing E stimate Simulation input: |Iight.vwf Add Multiple Files...

s Incremental Compilation

Simulation mode: |{Z8

- EDA, Tool Settings — Simulation period
- Design Entry/Synthesis * Bun simulation until all vector stimuli are used
- Simulation
- Timing Analysis " End simulation at; I r ]
- Formal Verification
i o Physical Synthesis Glitch flteie S
P g options: | Auto 3
© - Board-Level 1 _J
= Analysiz & Synthesiz Settings More Settings...
© - WHDL Input

- Werilog HOL Input

- Default Parameters

o Synthesis Metlist Optimizations
- Fitter Settings

s Phyzical Synthesis O ptimization
- Timing Analyziz Settings

- TimeGuest Timing Analyzer

= Claszic Timing &nalyzer Setting
: - Clazzic Timing Analyzer Re
- Azzembler Drescriptior:

- Diesign Assistant Specifies the type of simulation to perform for the current Simulation focus.
- SignalTap Il Logic Analyzer

Logic Analyzer Interface
- Simulator Settings

PowerFlay Power Analyzer Setting -

< | > B ok | Cancel

i

Figure 37. Specifying the simulation mode.

Simulation Waveforms
Simulation mode: Functional

h Master Time Bar: 0ps 1| ¥| Painter: BE4.33 nz Interval: BE4.33 nz Start: End:
A 0 pz 400 nz 80.0 nz 120.0 ns 160.0 nz 200.0 n4
N Walue at i i i i
o5 ame Ops 0 s
i

@)\ w0 «1 A0 |

1 %2 A0 | | |
Iy £ 2 f A0 | |
%,

Figure 38. The result of functional simulation.

6.1.2 Timing Simulation

Having ascertained that the designed circuit is functigradrrect, we should now perform the timing simulation
to see how it will behave when it is actually implemented ia thosen FPGA device. Sele&ssignments >
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Settings > Simulator Settings to get to the window in Figure 37, choo$é@ning as the simulation mode, and
click OK. Run the simulator, which should produce the waveforms guig 39. Observe that there is a delay of
about 6 ns in producing a change in the sigfidiom the time when the input signals; andx,, change their
values. This delay is due to the propagation delays in thie Elgment and the wires in the FPGA device.

Simulation Waveforms I
Simulation mode: Timing

h Master Time Bar: 0ps 1| ¥| Painter: 109.45 ng Interval: 109.45 ng Start: End:

A \alue ot 0 pz 4D.ID nz SD.ID nz 12DiD nz 1BDiD nz 200.0 n4
o Hlans Ops 0 ps

i
@\ w0 «1 A0 |
1 %2 A0 I | J

Py a2 f A0 J IS S NS S N
4]

Figure 39. The result of timing simulation.

7 Programming and Configuring the FPGA Device

The FPGA device must be programmed and configured to impletmedesigned circuit. The required configura-
tion file is generated by the Quartus Il Compiler's Assembiedule. Altera’s DE2 board allows the configuration
to be done in two different ways, known as JTAG and AS modeg cmfiguration data is transferred from the
host computer (which runs the Quartus Il software) to thedhdy means of a cable that connects a USB port
on the host computer to the leftmost USB connector on thedbdar use this connection, it is necessary to have
the USB-Blaster driver installed. If this driver is not ady installed, consult the tutori@etting Started with
Altera’s DE2 Boardfor information about installing the driver. Before usirgetboard, make sure that the USB
cable is properly connected and turn on the power supplychwin the board.

In the JTAG mode, the configuration data is loaded directly the FPGA device. The acronym JTAG stands
for Joint Test Action Group. This group defined a simple waytésting digital circuits and loading data into
them, which became an IEEE standard. If the FPGA is configuwrditis manner, it will retain its configuration
as long as the power remains turned on. The configuratiomniration is lost when the power is turned off. The
second possibility is to use the Active Serial (AS) mode.his tase, a configuration device that includes some
flash memory is used to store the configuration data. Quartaftivare places the configuration data into the
configuration device on the DE2 board. Then, this data isddaato the FPGA upon power-up or reconfiguration.
Thus, the FPGA need not be configured by the Quartus Il softiféine power is turned off and on. The choice
between the two modes is made by the RUN/PROG switch on thelldBi2l. The RUN position selects the JTAG
mode, while the PROG position selects the AS mode.

7.1 JTAG Programming

The programming and configuration task is performed as@loFlip the RUN/PROG switch into the RUN
position. Selecflools > Programmer to reach the window in Figure 40. Here it is necessary to §pdice
programming hardware and the mode that should be used. Hlreztdy chosen by default, select JTAG in the
Mode box. Also, if the USB-Blaster is not chosen by defauless theHardware Setup... button and select the
USB-Blaster in the window that pops up, as shown in Figure 41.
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U light.cdf [Z] [E] [g]

éaHardware Setup... USE-Blaster [USE-0] Mode: [JTAG | Progress: 1]

™ Enable realtime ISP ta allow background prograrring (for MAK || devices)

Exd

Blark-

Y Werify Check ‘ Examine

Configure

Wb Start | File ‘Device ‘Ehecksum

light.saf EP2C35FG72 O02Fa254 FFFFFFFF
*E'ﬂ Auto Detect
(2 4dd File...

IE >

Uszercode

Figure 40. The Programmer window.

Observe that the configuration flight.sofis listed in the window in Figure 40. If the file is not alreadstéd,
then click Add File and select it. This is a binary file produced by the Compil&ssembler module, which
contains the data needed to configure the FPGA device. Thasah.sofstands for SRAM Object File. Note
also that the device selected is EP2C35F672, which is theARRssice used on the DE2 board. Click on the
Program/Configure check box, as shown in Figure 42.

X

Hardware Setup
Hardware Seftings IJTAG Settings]

Select a programming hardware getup to use when programming devices. This programming
hardware zetup applies only ta the current programmer window.

Currently selected hardware:

Available hardware items:

Hardware Server | Fart | Add Hardware...
USE-Blaster Local UsE-n

Cloze

Figure 41. The Hardware Setup window.

U light.cdf*

éaHardware Setup... USE-Blaster [USE-0] Mode: [JTAG | Progress: 1]

™ Enable realtime ISP ta allow background prograrring (for MAK || devices)

Exd

W Start File Checksum Usercode E[oongfi[gaLT; Werify Elﬁggk Examine
light. sof O02F3284 FFFFFFFF

*E'ﬂ Auto Detect

¥ Delete

s Add File...

li= Change File... | F 3

Figure 42. The updated Programmer window.
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Now, pressStart in the window in Figure 42. An LED on the board will light up wiéhe configuration data
has been downloaded successfully. If you see an error expbytQuartus Il software indicating that programming
failed, then check to ensure that the board is properly pesven.

7.2 Active Serial Mode Programming

In this case, the configuration data has to be loaded intodhéguiration device on the DE2 board, which is
identified by the name EPCS16. To specify the required corstiun device selechssignments > Device,
which leads to the window in Figure 43. Click on tBbevice and Pin Options button to reach the window in
Figure 44. Now, click on th€onfiguration tab to obtain the window in Figure 45. In the Configurationidev
box (which may be set to Auto) choose EPCS16 and ¢ligk Upon returning to the window in Figure 43, click
OK. Recompile the designed circuit.

Settings - light

Category:
- General
- Files
Libraries Select the family and device you want to target for compilation.
Device -
[# Operating Settings and Conditions - Device Family - - Shaw in ‘Available devices' list-
: E;r;p.:_l‘;:g;rtionc;ss Jetings FEamily; IEch:Ione Il LJ Package: Any -
(¥ Analpsiz & Synthesiz Settings T > Fin count: Ay -
[# Fitter Settings e l " -—J )
# Timing Analysiz 5ettings = Speed drade: 1'6‘”-'" ]v
s Azzembler i~ Target device- - [~ Show advanced devices
- Design Assistant ™ Auto device selected by the Fitter ™ HadCany compatible only

i Slgr?aITap Il Logiz #ifiakizer i+ Specific device selected in ‘Available devices' list
Logic Analyzer Interface i

- Simulator Settings Blig= Sl Device and Pin Options.. ‘
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{1 migration devices selected ¥ Lt DSE & BaM ta HardCopy deyice resoursss

Figure 43. The Device Settings window.
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Device and Pin Options P§|

Fin Placement ] Error Detection CRC ] Capacitive Loading ] Board Trace Model ]
General l Configuration ] Programming Files ] Unuzed F'ins] Dwal-Purpoze F'ins] Voltage]

Specify general device options. These options are not dependent on the configuration
scheme.

Ot

[C1Releaze clears before tri-states
[C1Enable user-supplied start-up clock [CLEUSR]
[C1Enable device-wide rezet [DEY_CLRN]
[C1Enable device-wide output enable [DEY_DE]
[C1Enable IMIT_DOME output

[~ Auto usercode

JTAG uzer code [32-bit hexadecimal,  |FFFFFFFF

Diirects the device to restart the configuration process automatically if a data error iz
encountered. If this option is turned off, you must externally direct the device to

restart the configuration process if an ermor ocours.
Reset
(] 8 | Cancel |

Drescription:

Figure 44. The Options window.

Device and Pin Options Pz|

Fin Placement ] Error Detection CRC ] Capacitive Loading ] Board Trace Model ]
General  Configuration l Programming Files ] Unuzed F'ins] Dwal-Purpoze F'ins] Voltage]

Specify the device configuration scheme and the configuration device. Mote: For
HardCopy |1, these settings apply to the FPGA prototype device.

Configuration scheme: |Active Serial [can use Configuration Device] j
Configuration mode: | J

Configuration device
v Usze configuration device: Auto j

Auto
EPC51
EPCS4

v Generate compressed bitstreams |EPCSE4

Drescription:

Specifies the configuration device that you want to uge as the means of configuring
the target device.

Reset
(] 8 | Cancel |

Figure 45. Specifying the configuration device.

The rest of the procedure is similar to the one describedexfisthe JTAG mode. Sele@bols > Program-
mer to reach the window in Figure 40. In the Mode box sel&ctive Serial Programming. If you are changing
the mode from the previously used JTAG mode, the pop-up bdigare 46 will appear, asking if you want to
clear all devices. Clickes. Now, the Programmer window shown in Figure 47 will appeaak® sure that the
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Hardware Setup indicates the USB-Blaster. If the configomdtle is not already listed in the window, presdd
File. The pop-up box in Figure 48 will appear. Select the lidgat.pof in the directoryintrotutorial and click
Open. As a result, the configuration fileght.pof will be listed in the window. This is a binary file produced by
the Compiler's Assembler module, which contains the dataetdtoaded into the EPCS16 configuration device.
The extensionpof stands for Programmer Object File. Upon returning to theggyRnmmer window, click on the

Program/Configure check box, as shown in Figure 49.

current device list and switch to selected mode?

'E Some devices in current device list cannot be added to selected programming mode Active Serial Programming. Do you want ko clear all devices in
L

Figure 46. Clear the previously selected devices.
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Figure 47. The Programmer window with Active Serial Prognging selected.
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Figure 48. Choose the configuration file.
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Figure 49. The updated Programmer window.

Flip the RUN/PROG switch on the DE2 board to the PROG positiBressStart in the window in Figure
49. An LED on the board will light up when the configurationaldas been downloaded successfully. Also, the
Progress box in Figure 49 will indicate when the configuraiad programming process is completed, as shown
in Figure 50.
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Figure 50. The Programmer window upon completion of prognamg.

8 Testing the Designed Circuit

Having downloaded the configuration data into the FPGA dgwou can now test the implemented circuit. Flip
the RUN/PROG switch to RUN position. Try all four valuatioofsthe input variables:; andx,, by setting the
corresponding states of the switche¢l’; and SW,. Verify that the circuit implements the truth table in Figur
11.

If you want to make changes in the designed circuit, firsteldse Programmer window. Then make the
desired changes in the Block Diagram/Schematic file, cantpi¢ circuit, and program the board as explained
above.
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